
 

ArcGIS Pro is the latest professional desktop GIS application from Esri. 
With ArcGIS Pro, you can explore, visualize, and analyze data; create 2D maps 
and 3D scenes; and share your work to your ArcGIS Online or ArcGIS 
Enterprise portal. The sections below introduce basic elements of the user 
interface. You will build on this knowledge as you use the application, read the 
help, and complete the tutorials. 

Sign in 

To start using ArcGIS Pro, you typically sign in with the credentials of your ArcGIS 

Online or ArcGIS Enterprise organization. Signing in is required if your software license is 

managed by your ArcGIS organization, which it is by default. Signing in also enables you to 

access web content, such as web maps, stored in your organization and other online repositories. 

Projects 

In ArcGIS Pro, a body of related work—consisting of maps, scenes, layouts, data, tables, tools, 

and connections to other resources—is typically organized in a project. By default, a project is 

stored in its own system folder. Project files have the extension .aprx. A project also has its 

own geodatabase (a file with the extension .gdb) and its own toolbox (a file with the 

extension .tbx). 

When you start ArcGIS Pro, you can create a project from one of the four system templates. 

Each template creates a project file that starts the application in a different state. For example, a 

project created from the Map template starts with a map view containing a basemap layer. You 

can also start without a template. This allows you to work in ArcGIS Pro without saving a 

project file. 

New projects can also be started from project templates made by you or shared with you by 

colleagues. A project template is a customized starting state for a project. Recently used 

templates appear on the start page. You can also browse to templates. 

There are various ways to open your saved projects. Any project you have used recently is 

accessible from the start page. You can browse to other saved projects to open them. You can 

also pin a project to the start page to make sure it is always readily available. 

https://pro.arcgis.com/en/pro-app/2.8/get-started/pro-quickstart-tutorials.htm
https://pro.arcgis.com/en/pro-app/2.8/help/projects/sign-in-to-your-organization.htm
https://pro.arcgis.com/en/pro-app/2.8/get-started/named-user-licenses.htm
https://pro.arcgis.com/en/pro-app/2.8/help/projects/what-is-a-project.htm
https://pro.arcgis.com/en/pro-app/2.8/help/projects/create-a-new-project.htm
https://pro.arcgis.com/en/pro-app/2.8/help/projects/create-a-new-project.htm#ESRI_SECTION1_D3876767A5924C60977A2F16F7181871
https://pro.arcgis.com/en/pro-app/2.8/help/projects/create-a-new-project.htm#ESRI_SECTION1_DD76FA05A28C4C25B8F69CEB847C0108
https://pro.arcgis.com/en/pro-app/2.8/help/projects/open-a-project.htm


Projects are opened and created on the start page. 

ArcGIS Pro start page elements 

Element Description 

 

Sign in to ArcGIS Pro with your ArcGIS organization credentials. 

 

Open a recent project. To open a project not on the list, click Open another project . 

 

Create a project from a default ArcGIS Pro template. 

 

Access learning resources, including tutorials, courses, community support, blogs, and 

documentation. 

 

Create a project from a custom template. To create a project from a template not on the list, 

click Select another project template . 

 

Access project and application settings. 

ArcGIS Pro user interface 

The main parts of the ArcGIS Pro interface are the ribbon, views, and panes. For a hands-on 

introduction, try the Introducing ArcGIS Pro quick-start tutorial. 

Ribbon 

https://pro.arcgis.com/en/pro-app/2.8/get-started/introducing-arcgis-pro.htm


ArcGIS Pro uses a horizontal ribbon at the top of the application window to display and organize 

functionality into a series of tabs. Some of these tabs (core tabs) are always present. Others 

(contextual tabs) appear when the application is in a particular state. For example, a set of 

contextual Feature Layer tabs appears when a feature layer is selected in the Contents pane. 

 

ArcGIS Pro ribbon elements 

Element Description 

 

The Quick Access Toolbar has commonly used commands. 

 

The Explore tool is used to navigate maps and scenes and identify features through pop-ups. 

 

Ribbon tabs, such as the Analysis tab, organize functionality. When a tab is selected, its 

associated tools display on the ribbon. 

 

Dialog box launchers open panes or dialog boxes with more functionality. 

 

Groups organize functionality on a ribbon tab. 

 

Contextual tab sets and their associated tabs appear under specific conditions. Contextual tab 

sets are highlighted in a color such as orange or green. 

 

Buttons and tools execute software actions. 

You can customize the ribbon and the Quick Access Toolbar. 

You can click a tool on the 

ribbon to add it to the Quick Access Toolbar. 

Views 

https://pro.arcgis.com/en/pro-app/2.8/get-started/quick-access-toolbar.htm
https://pro.arcgis.com/en/pro-app/2.8/help/mapping/navigation/navigation-in-arcgis-pro.htm
https://pro.arcgis.com/en/pro-app/2.8/help/mapping/navigation/pop-ups.htm
https://pro.arcgis.com/en/pro-app/2.8/get-started/customize-the-ribbon.htm
https://pro.arcgis.com/en/pro-app/2.8/get-started/quick-access-toolbar.htm


Views are windows for working with maps, scenes, tables, layouts, charts, reports, and other 

presentations of data. A project may have many views, which can be opened and closed as 

needed. Several views can be open at the same time, but only one is active. 

 

An ArcGIS Pro map view 

Element Description 

 

A map view is a window that displays a map. 

 

Every view has a tab that can be used to close the view or drag it to a different 

position. The tab of the active view is blue. Clicking a view tab makes the view 

active. 

 

  

https://pro.arcgis.com/en/pro-app/2.8/help/mapping/map-authoring/maps.htm
https://pro.arcgis.com/en/pro-app/2.8/help/mapping/map-authoring/scenes.htm
https://pro.arcgis.com/en/pro-app/2.8/help/data/tables/open-tabular-data.htm
https://pro.arcgis.com/en/pro-app/2.8/help/layouts/layouts-in-arcgis-pro.htm
https://pro.arcgis.com/en/pro-app/2.8/help/analysis/geoprocessing/charts/what-is-a-chart-.htm
https://pro.arcgis.com/en/pro-app/2.8/help/reports/reports-in-arcgis-pro.htm


Panes 

A pane is a dockable window that displays the contents of a view (the Contents pane), the 

contents of a project or portal (the Catalog pane), or commands and settings related to an area of 

functionality, such as the Symbology and Geoprocessing panes. 

 
Panes offer functionality that is more advanced or complete than ribbon commands. Panes may 

have rows of text tabs and graphical tabs that partition and organize functionality. 

https://pro.arcgis.com/en/pro-app/2.8/help/mapping/map-authoring/contents-pane.htm
https://pro.arcgis.com/en/pro-app/2.8/help/projects/the-project-pane.htm#ESRI_SECTION1_A70CD55DADDD4E8E80A2EC07D91113C6


 

Element Description 

 

Some panes have more than one page. Use the Back button to switch pages. 

 

Text-based primary tabs, such as Gallery and Properties, partition the pane's functionality. 

 

Graphical secondary tabs partition the functionality of a primary tab. 

 

Expanders are small arrows that you click to show or hide settings. 

 

The Menu button contains additional commands. 

 

Handles allow you to resize areas of a pane by dragging. Handles can be horizontally or vertically 

oriented. 

 

The first time you open ArcGIS Pro, the Contents and Catalog panes are open, and all other 

panes are closed. If you've used ArcGIS Pro before, the same panes that were open during your 

last session remain open the next time you start the application. 



You can manage panes on the View tab of the ribbon. In the Windows group, 

click Contents  or Catalog Pane  to open these panes if they are closed. Click Reset 

Panes  to choose a specific pane configuration. 

Settings page 

On the Settings page, you can perform basic file operations and configure the application. 

The Settings page can be accessed in two ways: 

• From an open project, click the Project tab on the ribbon. 

• From the ArcGIS Pro start page, click Settings  in the lower left corner. 

Click the tabs on the left side of the page to access the settings you want to change. 

 



 

 

ArcGIS Pro Settings page 

Tab Description 

New Create a project. 

Open Open an existing project. 

Save Save your current project. 

Save As Save a copy of your current project. 

Portals Manage portal connections and set your active portal. 

Licensing 
View license information, authorize ArcGIS Pro to work offline, and change your license 

type. 

Options 
Access general project and application options as well as options for specific functional 

areas such as editing, layout, and geoprocessing. 

Python Configure Python environments and packages. 

Add-In 

Manager 
Install add-ins to customize ArcGIS Pro. 

Help Open the online or installed help system. 

About View information about your ArcGIS Pro version and update to the latest version. 

Exit Exit the application. 

 

 

  

https://pro.arcgis.com/en/pro-app/2.8/help/projects/create-a-new-project.htm
https://pro.arcgis.com/en/pro-app/2.8/help/projects/open-a-project.htm
https://pro.arcgis.com/en/pro-app/2.8/help/projects/save-a-project.htm
https://pro.arcgis.com/en/pro-app/2.8/help/projects/save-a-project.htm#ESRI_SECTION1_3DF32703CF96472384AE757C155039FC
https://pro.arcgis.com/en/pro-app/2.8/help/projects/manage-portal-connections-from-arcgis-pro.htm
https://pro.arcgis.com/en/pro-app/2.8/get-started/start-arcgis-pro-with-a-named-user-license.htm#ESRI_SECTION1_12B9612BADDF4FEAB7211C7D7FC3ADE7
https://pro.arcgis.com/en/pro-app/2.8/get-started/options.htm
https://pro.arcgis.com/en/pro-app/2.8/arcpy/get-started/what-is-conda.htm
https://pro.arcgis.com/en/pro-app/2.8/get-started/manage-add-ins.htm
https://pro.arcgis.com/en/pro-app/2.8/get-started/view-help-for-arcgis-pro.htm
https://pro.arcgis.com/en/pro-app/2.8/get-started/update-arcgis-pro.htm


 

 

Exercise 1 

At the beginning of each exercise, it is possible that you may need to log in. 

 

Signing in is simple 

Click on the Not Signed in option in the upper right corner of the application will bring up the Sign In 

interface 

 

For everything we are doing today please us the credentials you were emailed and the password you 

setup in that process. If you have forgotten the password or it isn’t working let me know and I will reset 

it. 



 

It should look something like this. When you enter your credentials you should see something like this 

appear in the upper righthand corner. 

 

With the basic log in out of the way we will cover some of the very basics of the application. 

1) Adding data 

 

In the map ribbon select the add data button 

  

This will bring you to an interface that allows you to add data from a variety of sources 



Local data 

Local data will be found by using the interface to guide yourself to the DM-Pro directory we installed. 

In the left-hand pane of the interface select This PC > Windows C: > DM-Pro > DroughtAreas 

From this directory select Drought_Areas_US_D0.shp and click Ok

 

This should bring in that layer and symbolize it randomly. Lets leave it for now. 

Web data 

The first web data we will add is from our training dataset in the UNLDroughtCenter portal. Your 

organization will likely have their own portals and later these various portals can share access to 

datasets and between users. 

To add our first web data we follow the same steps as for the local data but instead of going to This PC 

the path we should follow is:  Portal > My Groups 

  

You should see these datasets 



 

Select USGS Streamflows and click Ok 

 

Your map should look something like this. 

 



To view the USGS Streamflow data click the arrow to the left of its name and click in the check box to 

the left of the dataset you wish to view.

 

Zoom into the view by moving your cursor over the middle of the U.S. and roll your mouse wheel 

forward for zooming in and backward for zooming out. 

2) Labeling 

Labels work very similarly to the previous version. They are accessed via right click to access the context 

menu. 

Turning labels On/Off move your cursor over they feature set you wish to affect the labels of. Click on 

the name will bring up the Context menu and in the middle of the list should be a selection called label 

selecting it will turn the labels on or off depend on their state when you open the menu. 

 



 

 

To change the Display Field used to create the labels follow the same instructions as 

turning label on and off but instead select Labeling Properties. 

This will bring up the Label Class – Realtime interface. Here you can change the fields 

that are used to label the features. You can also create expressions to combine fields to 

make complex labels 

Change your language drop down to VBScript 

Into the Expression box type this in exactly. 

[STAID]&VBNewline&"Flow "&[FLOW]&VBNewline&[PERCENTILE] 

Hit the Apply button at the bottom of the interface. 

 

 

 

Your features should now display like the image above. 

Note: Labeling changes are a property of the Map Document. When you open or create a new 

document and add this data you will need to redo this work to get the same label result. 

 

 

 



3) Symbology 

Symbolizing or changing symbology on datasets. This is also accessed 

by right clicking on a feature in the Contents pane and selecting 

Symbology in the context menu  

 

 

This should bring up the Symbology interface. This interface will allow you to change the feature in all of 

the same ways as the previous version. There are more options, so the interface is more complex than 

the previous version. 

 

Click on the colored box next to Symbol 

 

You can choose premade symbol or like we will do here we can customize it ourselves by selecting the 

Properties tab at the top of the interface 



 

Clicking on the Color patch will bring up the set colors. We want to select the third yellow from the top. 

If you hover over the patch the name Solar Yellow should appear. Once you select this color change the 

outline width 0pt and at the bottom of the interface hit Apply. 

 

Your map should look like this. 

4) Feature Layer Properties 

With the newly symbolized Drought_Areas_US_D0 highlighted in the Contents pane Select Feature 

Layer in the ribbon. 

 



The various options for the Feature layer can be accessed and set here. 

In the Transparency box experiment by typing in various numbers between 0 and 100. If you type 0 the 

feature is opaque if you type 100 the feature become totally invisible. Normally I use from 30-60 

depending on what suits best 

 

 

 

 

 

  

 

Swipe 

Swipe is a new tool that may be helpful to the Authors.  

In the same Feature Layer ribbon click on Swipe in the Compare tab. When you move your cursor over 

the map your cursor will turn into an arrow. Notice as you move around the map the arrow points in 

different directions as you get closer to the edges of the map. Click on the map and hold it down, now 

move your cursor in the direction the arrow is pointing.  

 

This is a partial swipe down. 

This tool can be used on any feature layer, you just have to highlight it in the Context pane and then 

select the Swipe tool in the Feature Layer ribbon.  To deactivate the swipe tool go back to the Map 

ribbon and select the Explore tool in the Navigate tab. 

20% Transparency 50% Transparency 



 

 

5) Project properties 

 Selection 

Selectivity is control very similarly to ArcGIS Desktop, to access the selection interface click the third icon 

in the Contents pane.  

 

As you can see each of the layers in the project have check boxes. The USGS Streamflow along with the 

World Topographic map and the World Hillshade have filled boxes. This means that there is no data to 

be selected, in the case of the USGS Streamflow it is a container for the actual selectable data and the 

two other features are for display and contain no selectable attributes. 

The datasets that are selectable are shown with checkmarks next to their names. This means that when 

they are both Turned on in the Drawing order pane and list by selection pane as you move your mouse 

over any of these features you can right click and return their information 

  

This should include points, lines, and polygons along with raster that have attribute data. 

Use the next few minutes and select various points and area feature and look at the available data. As 

you can see above this can even include links to external data. 

 Editing 

Editing requires a bit more care n ArcGIS Pro. Where ArcGIS Desktop made you choose the source that 

you want to edit, ArcGIS Pro gives you the ability to edit any dataset you have the editing rights to.  

Furthermore, it sets their properties selectable and editable by default. So unlike Desktop you can 



switch between editing drought areas and impacts without stopping edit of one and starting editing of 

another. To activate or deactivate a feature set to be editable you click the fourth icon, that of a pencil 

to open the List by Editing tab 

 

It looks and function similarly to the other tabs we have discussed. In addition to the filled boxes you can 

also see that there are red circles with exclamation points in them. These denote feature that you don’t 

have permission to edit. This tab is the most important to keep in mind when editing. You no longer 

have the safety of not having activated editing on a feature set, in many ways more convenient but also 

a real danger if you lose track of what you are editing. 

To be available to be edited a feature data set needs three things; to be selected in the drawing order 

tab, to be selected in the list by selection tab and finally to be selected in the list by selection tab. 

Spend a few minutes selecting features and turning off and on various features attributes. Getting 

comfortable with these setting will help you when you edit data later in this session. 

 Snapping 

The third tab of importance in the Contents pane is the list by Snapping. This allows you to have granular 

control of what features you would like to snap to during your editing.   

 



To snap to a feature, it needs only to be check in the Drawing order and in the Snapping tabs it does not 

have to be selectable. The only additional requirement is that the Snapping tool in the Edit ribbon is 

active. When the tool is active it appears highlighted in the editing ribbon. 

 

Spend a little time snapping the vertices of the Drought_Areas_US_D0 to various Streamflow points. 

Don’t worry about messing things up, these are practice datasets and to the left of the Snapping tool 

there is a Save icon and Discard icon, you can edit as much as you want and if unsatisfied at the end you 

can discard the changes. These replace the Save Edits in the drop down menu of the previous version.  

 

  



Exercise 2 

Tools 

ArcGIS Pro has many of the same tools as ArcGIS Desktop, some you may have used and other you may 

not. Most of them work the same way as the previous version while some have been expanded and 

improved. This will be a fairly short exercise getting you familiar with the different ways to accomplish 

the various tasks required when doing basic editing. Please go to C:\DM-Pro\Excercises\Excercise-2 and 

open Tools.aprx. You should still be logged into the portal, if you are not please refer back to the 

previous exercise and follow the login portion of the instructions. 

Navigate 

Navigating in a project is one of the most important things to master in any GIS interface. Its how you 

are able to get around the data and the better you are at it the faster you can get your edits done. 

ArcGIS Pro has a number of tools that help you navigate and to return to specific areas. 

Mouse navagation 

The default navigation is using the mouse and mouse wheel. If you hover over the Explore tool 

in the Map ribbon you will see the tool explanation below. 

 

This gives you helpful shortcuts for many actions. 

Spend a little time using the various mouse actions to zoom in and out and to pan across the 

page. When you become comfortable with using the mouse to move around you can left=click 

on the USDM_raw_training in the Drawing order of the Contents pane and select zoom to layer 

to return to the full extent. 

Zoom in by rectangle (not shown by default) 

The ArcGIS Pro interface doesn’t include this tool by default, but I find it is useful to have in the 

project. To install it select the customize arrow on the small tool bar in the very upper left 

corner of the Project. The Rectangle zoom in is the eight choice down for the quick access 

toolbar 



 

As you can see the Zoom in icon now appears on the quick access tool bar. This is a change that 

should now be in every project you open. It is written to the template as a preference. This is 

another similarity between ArcGIS and Microsoft products like Office applications. 

 

Extents 

As you zoom in and out around the page and pan to various places you may find you need to 

return to an area you had just been a few click before. This is a case for using the Previous and 

the Next extent tools in the Map ribbon. By clicking on the blue arrows you can step forward or 

backward in your movements across the Map view. The left pointing arrow is Previous extent 

and the one pointing right is to go to the next extent. If neither is blue you have yet to move in 

the map. If the next isn’t blue then you haven’t made an additional move or to state it another 

way you are at the end of the trail of movement. 

  

Bookmarks 

This is a helpful feature if you find yourself going back to an area multiple times. You can set a 

bookmark and when you select it from the dropdown it will zoom you back to the location and 

extent that you set  

Please zoom into the area near Seattle Washington using whatever method you prefer. 



  

Select New Bookmark from the Dropdown 

 

You can then Name, add a description and save the bookmark. This bookmark will then be 

available to use when you go back to that bookmark dropdown. These bookmark are specific to 

the map document. You can export them and import them into a new document similar to the 

way they are used when printing the current CONUS quadrant maps. 

Inquire 

 Locate 

 Locate is one of the tool that seems to be improved in ArcGIS Pro. It allows google-like look up 

for areas and addresses without requiring tool setup. The binoculars icon in the Inquiry tab of the Map 

ribbon allows you to by default search (general 

search) or search by Layer. The general search 

allows you to type in some general description; 

zipcode, town, address or partial address. 

 

 



It will return a list of possible candidates to choose from and you can right click on these options and 

zoom or pan to them.  You can also add a graphic to the location for ease of locating it again. 

 

  



Exercise 3 

Editing 

The bulk of Editing is the setup. We have already covered the basic steps to start editing in the previous 

exercises, getting to the right location, making sure the proper layers are editable and setting the 

snapping environment. 

Add a new feature 

Points 

For this exercise go ahead and make sure your Local Version of the data is the One you are 

actively editing. If you aren’t sure, refer to the section on setting layers selectable and editable. For this 

you can turn on background data to immolate the actual authoring process or leave it off to focus on the 

editing process, it’s your choice. Now open the Edit ribbon for the map view and select the Create icon 

in the Features tab. 

 

When you get to this interface it show the placement tools for Impact Labels. Go ahead and 

place a new impact label. Notice that it only shows up while selected , this is a result of it having only a 

label and no symbology. If you unselect this new point it will be come invisible until you give in an 

attribute in the next step. 



 

Return to the contents pane by clicking the tab at the bottom of the Table of Contents. Highlight 

the Impact S-L feature and either right click and open the attribute table from the context menu or use 

the ctrl-t shortcut to open it. Notice there is selected record in the table and it is blank. Fill in this record 

with your choice of S, L, or SL and then hit return or click on another point’s attribute and you can see 

that the map now shows the label. 

 

Deleting points can be difficult as without symbology you must use the attribute table to select a 

point to either change its attribute or to delete it entirely. 



 

As you can see in this example I have highlighted the feature by selecting it in the table and I can 

now delete it by using the Delete Icon in the top bar of the attribute table.

 

And poof it is gone! 

Lines 

Creating a line is the same as the previous application. Make sure you have turned on the 

editing for the local version Impact-LinePointers and open the Create features tool the same way you 

did for the points above.  



 

 As you can see there multiple ways to create the line and you should only need to use the first 

 

 The tool operates the same ways as the one in the prior application, click in your starting 

location and draw to your ending location and at that point either click to add the point and right click 

for the context menu so you may select finish or you can simply double click to finish the line.

 

 The new feature then appears. 

Polygons 

 



 

Again these process is the same as in the previous application. Make sure you now have the 

polygon feature editable. You may then go to the Create feature interface in the same manner 

as the two previous editing sessions. Just as with the line and point the first tool (Draw Polygon) 

is the one you should use 99.9% of the time for creating a new feature.

 

Just as with the line when you are finished either click to add the final vertex and right click for 

the context menu so you may select finish the sketch or you can simply double click to finish the 

polygon. 



 

Our new polygon. 

For the following exercises we will be editing D3 in our Local data sets in the Texas area.

 

Split (Cut) an existing feature 

Turn on the editability for our Local D3. Now in the Edit ribbon select the Select tool from the Selection 

tab. You may want to turn off the selectivity for the other Layers as well as there editability just to 

ensure that you aren’t accidentally editing other layers. Now select the large D3 feature covering central 

Texas. 



 

We can now preform the following operations on our data.  

Cut a hole 

With our feature selected we now go to the Edit ribbon and select Split from our Tools tab, this will bring 

up the Modify Features interface. Find an open area of D3 and cut a hole in it. The important thing to 



remember is that to successfully cut a hole the last arc must CROSS one of the previous arc in your 

sketch if it doesn’t the operation will fail. 

 

 Notice the my final arc is crossing the first arc I drew. 

  

Like in the previous application the result is two selected features, your cut area and the 

remainder of the existing polygon. You will then need to unselect the remainder polygon and then you 

can safely delete the piece you have split from the larger feature. 

Cut a piece off existing polygon 



 

With our large D3 selected again let’s cut a piece off of the southern end of the feature. The rule to 

follow here is the same as in previous applications you must start the process out side of the target 

polygon and end it outside of the target polygon. The cut will then follow the path that your arcs 

traveled across the polygon. You can then follow the same procedure to ensure you delete only the part 

of the polygon that you cut off. 

Cut a piece out of a complex polygon. 

Our large D3 should once again be selected. If you look at the south-central portion of the feature you 

will see several wholes that expose the D2 layer below. To connect two of these holes requires a bit of 

technique. You can once again select the split tool 

 

As you can see this leaves us piece to delete between the two holes resulting in a larger whole. 

 

Merge existing features 



Merging features is a good way to make changes to the extent of a polygon without having to do tedious 

editing of vertices on and existing polygon. With our D3 as our editable layer we will close in an area of 

D3 just above of the feature holes we just connected. Activate the Create feature tool for the D3 just as 

we have done for the previous polygon additions

 

As you can see the polygon we have drawn covers a large area of D2 and over laps 2 unconnected D3 

polygons. We now need to turn these 3 separate polygons into one connected feature. 

 

To accomplish this we go back to our Edit ribbon and choose our Select tool. We then need to select all 

three of the polygons so they can then be merged. You can hold down shift and click on the all of the 



polygon that need to be merged.

 

The result should look something like this. 

While these are selected return to the Edit ribbon and select Merge from the Tools tab. 

 

This differs from the previous application where selecting the merge option from the edit dropdown 

emidiatly started the function. In ArcGIS Pro you will need to click the Merge button at the bottom right 



of the Merge interface

 

This is the resulting merged polygon. 

Saving Edits 

Just as in the previous application no edits are final until they are saved. To save in ArcGIS Pro return to 

the Editing ribbon and in the Manage Edits there is a save and a discard icon. My advice is as you are 

editing when you finish an edit and you think to yourself “Boy, I don’t want to do that again.” I would 

immediately save my edits. This will prompt you to assure them again that you do want to save your 

edits. 

 

These are the basics of the Editing of data. For the rest of the time we have allotted edit the various 

datasets. Try edit the USDM_raw_training, this is a shared Web dataset all should have full access to and 

I think it would be interesting to show what happens when several people edit the data at the same 

time.  

 

 

  



 

Exercise 4 

Mapping 

The aprx should contain the old USDM map template and meant to show the export of draft maps for 

review. The exercise will shown changing label placement, adjusting line sizes to improve map look as 

well as adding text to the map layout to indicate versions or updating other information.  

When we look at the map it look good, but if you continue to look at it you can see some issues that you 

may wish to clear up even in a draft map.

 

The things that could be cleaned up: 

1) The labels seem to not be center on their points 

2) The Callouts in Hawaii seem to be a little too thick 

3) The Impact Lines in the U.S. seem to be too thin. 

4) The Author name and the map dates are also incorrect so we can update these as well. 

5) And the last item to add would be to add Draft # or Final as text labels to the layout before 

exporting. 



We will start with issue 1 and work our way to the final issue and se what the final map looks like. 

To fix label placement we first need to go to the data frame to access the label  class interface

 

You can see that the Hawaii frame is available so click on that tab for it and you should in the right 

space. You can start to see the difficulty of creating the maps as in this view things look ok if a bit small. 

Additionally, the call outlines look fine as well. 

 

 

To fix the label placement select the Drought_Impacts_Type and right click to get to the context menu 

and select the label properties to open that interface to make the necessary changes.  



 

Once in this interface you choose the position tab and you can see that the label is set to be always to 

the upper left. What is needed is for the label to be placed on top of the point. Select that radio button 

and close the interface. In the view the point moves but you can’t barley see the difference. 



 

Let’s change the Callout line weight and by left clicking directly on the line symbol in the Contents pane. 

This will directly open the Symbology interface. Change the current value of 2 pt to 1.75 pt and click 

apply. 

 

Look at the difference in label placement and the slightly thinner callouts, pretty! 



Let change the thickness of the Impact Lines in the CONUS frame. We do this by selecting the CONUS tab 

and selecting the symbol for the Drought_Impacts_US and directly accessing the Symbology interface. 

 

 

Change the current Outline width from 1 pt to 2 pt. Once you click apply return to the Layout frame and 

look at the changes. 

 



Finally lets work on the text that is in the Layout frame itself. 

When in the layout frame select the Layout ribbon then select the Select tool from the Elements tab the 

select by rectangle will work for what you need to do. To get to the elements properties use the tool to 

select a feature with a single click and then right clicking to get to the properties interface via the 

context menu. You can also double click the element to go directly to its properties.

 



Change it to your name and either close the interface or just go back to the Layout tab and view the 

changes in the layout.

 

The last change we want to make before we export or print maps is to add a DRAFT # or a FINAL note to 

the map. 

To accomplish this, you need to go to the Insert ribbon while you are in the Layout view. In this ribbon 

all of the various elements that can be added to the layout available to be placed and their properties 

may be altered. 



 

Lets add our Draft or Final text, you choose. To accomplish this, we will go to the Graphics and Text tab 

of the ribbon and select the third option of the graphics choices Straight Text. Once you have clicked on 

this tool move your cursor to the layout and click, hold down and drag a box to the approximate size 

text you want (if it too big or small we can fix that later). When you complete this the text element 

properties box should appear and you may type in the text you want and you can also select the Text 

symbol tab to change nearly every aspect of the text. Lets change the color to Red and the Font size to 

24, look at the changes when you click apply. The last thing we will do is put an additional text element 

that matches the first. 

 

While the text element is still selected right click and select copy from the context menu and then do 

this again and select paste. You can also use the windows shortcut ctrl-c and ctrl-v to do the copy paste. 



Once the copy appears select it and draw it to where you want it displayed. There is the final map ready 

to be made into a document or printed. 

Our last operation is to put this map into a format that allows it to be sent to other, whether that is an 

ellectronic or physical document or both is up to you. The place where this is accomplished is in the 

Share ribbon. Click on this ribbon and you see a number of options, we are interested ion the Ouput tab. 

The the clipboard is self explanitory, it makes a copy of your view in clipboard and allows you to paste it 

directly into any socument that will accept input from the clipboard. The other are also very familiar 

interfaces. 

The Print Layout interface functions exactly like most other windows based applications with the various 

printers and options including whatever specialty print drivers you have access to like print to pdf. 

The Export Layout function like the prior applications export function but with mmore robust options 

including 12 filetypes to export to and access to more advanced functions like Image Compression and 

graphic extent clipping to limit file sizes. 

 



To finish this exercise export your final map to PDf and to PNG. If you are feeling adventerous do a few 

exports of the same file type but changing some of the availble attributes and compare the file sizes and 

quality! 

  



I hope you have gotten some confidence out of this short workshop. Over the next year or so we 

(NDMC) will be adding to the test data in the training group and we will leave this open for existing 

authors to homne their skills without worries about deleting important data. We will also be using it as a 

sandbox to allow testing of any new tools we will be deploying for use when the final move to ArcGIS 

Pro is made. I will always be available for additional Zoom training or help session if there is something 

you what to work on. I also imagine once we have done this training we will see a number of things to 

add or delete and Im certain folks like Rocky and Adam will have things they have found that we may 

want to incorporate into the training and at some point in six month or more we may want to schedule 

an new trainig that may incorpaorate new features new tool or new Authors.  

I have also included a short introduction to ArcGIS Pro stiolen directly from an ESRI website for refernce 

purpouses. Parts are extremly helpful and show many of the availble shortcuts that can save you time 

and other parts are there because if I tried to cut them out the pages looked funny. 

 

Chris Poulsen 

402-214-9055 (Cell) 

cpoulsen2@unl.edu 

 

 

 

 

 

 


